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Using the Spectrum Server program

Most of the Spectrum program documentation in this Spectrum CIRC/CAT User Manual
is designed for the librarian using Spectrum client programs (such as Spectrum
CIRC/CAT and Spectrum Patrons’ Catalog). However, this chapter explains server
program issues, as opposed to client program issues, and may be of special interest to the
server administrator rather than the librarian.

Note: Most processes described in this chapter require that you have direct access to the
server computer.

Spectrum Server responsibilities
Some aspects of operating the Spectrum Server program are usually the responsibility of
the server administrator. However, the responsibility for each of the following server-
related duties depends on the policies, personnel, and physical setup of your institution.

• Installing. The Spectrum Server software must be installed on the
server computer. Once installed, no further action may be required
unless the server program must be reinstalled or moved to another
location on the server computer.

• Starting. The Spectrum Server program can be started by anyone with
access to the program file (ctsrvr.exe on Windows and ctsrvr.nlm on
Novell). Note: The Spectrum Server administrator password is not
required to start the program.

• Shutting down. Shutting down the Spectrum Server program is
usually a job for the server administrator. Note: The Spectrum Server
administrator password is required to stop the program.

• Safeguarding. Safeguarding the Spectrum Server program and its data
physically and by use of a password is recommended.

• Monitoring/troubleshooting. Keeping track of server activity and
addressing problems is usually the server administrator’s
responsibility because it requires direct access to the server computer.

• Backing up/restoring. Making backups of server-controlled data and
restoring data from a backup are usually the server administrator’s
responsibility because they both require direct access to the server
computer.
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Understanding server programs and files
When you use the Spectrum CIRC/CAT program, you may use numerous program and
data files. Below is an overview of most of these files.

Program or file Definition

Spectrum Server The program that controls how Spectrum client
programs access Spectrum database files. This program
(also called the FairCom Server program) is installed on
your server computer.

Spectrum database
files

The data that your Spectrum Server and Spectrum client
programs use, such as material records, setup options,
and so on. These files are located on your server
computer.

Configuration file
(ctsrvr.cfg)

A text file that contains settings for the Spectrum Server
program.

Important! You must not move or remove this file.
This file contains information that optimizes Spectrum
Server.

Administrator program
(ctadmn.exe)

A program that lets you administer and protect your
Spectrum Server program.

Status file (ctstatus.fcs) A log file of server activity. This file is created and
maintained by the Spectrum Server program. You can
use it to monitor server activity.

FairCom
Administrative file
(faircom.fcs)

A log file that records administrative information,
including the Spectrum Server password.
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Program or file Definition

Transaction
management files

Files with an .fcs extension that manage transaction
processes. The following are examples of these files:

I0000000.fcs

D0000000.fcs

S0000000.fcs

S0000001.fcs

Important! These files must not be deleted, unless
directed by Sagebrush under special circumstances such
as a restore.
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About the Spectrum Server configuration file

Your Spectrum Server program may not need any additional setup. As soon as you install
it, Spectrum Server is ready to run. However, if you need to change the way your
Spectrum Server program operates, you can do so by editing a text file (ctsrvr.cfg) that
contains configuration settings for Spectrum Server.

Each time you start the Spectrum Server program, it immediately looks for its
configuration file (ctsrvr.cfg), which is located in the same folder as your Spectrum
Server program. This text file is installed on your server computer when you install the
Spectrum Server program.

Important! You must not move or remove the ctsrvr.cfg file. This file contains
information that optimizes Spectrum Server.

Your configuration file may contain information on memory management, the maximum
number of files to have open at one time, and the number of users that can access the
server. Some settings, such as supported communication protocols and any automated
backup process, are entered in the configuration file when you install the Spectrum
Server program.
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Configuration file settings
Below are descriptions of most settings that a Spectrum Server’s configuration file
(ctsrvr.cfg) may contain. Although these settings are listed in alphabetical order below,
you can include them in the configuration file in any order. To modify the configuration
file settings, see "Editing the configuration file".

Command Description and valid value(s)

COMM_PROTOCOL A valid communications protocol for this type of server. Some
Spectrum Servers support several protocols at the same time. For
example, for Novell servers, valid protocols can be F_TCPIP and
FSPX. You need a separate COMM_PROTOCOL line in the
configuration file for each communications protocol supported.

CTSTATUS_SIZE Lets you control the maximum size of the log file (ctstatus.fcs). The
value you enter is the approximate size in bytes for the ctstatus.fcs
file. The default is 65536. Do not delete the minus sign in front of
the number.

DUMP The name of the script file that specifies when and what to include
in a backup or restore process. If you use the DUMP command, be
sure that the listed script file is in the same folder as the Spectrum
Server program. Spectrum Server looks for this file only in its own
folder. If it doesn’t find it, the server immediately stops and
displays error #12 ("File not found"). For more information about
this command, see "Changing the scheduled backup".

FILES The total number of files (data files and index files) that the server
can open at one time. Before you change this setting, you must
contact a Sagebrush Technical Support Specialist. The default is
255.

PAGE_SIZE A "page" is a continuous block of memory locations. You can
specify the size of this block of memory. Before you change this
setting, you must contact a Sagebrush Technical Support Specialist.
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Command Description and valid value(s)

LOCAL_DIRECTORY The path to the folder where your Spectrum program and database
files are located. This command is only used by Novell or Windows
NT/2000 servers. The default location for Novell is sys:\Spectrum\
and for Windows NT/2000 is C:\Program
Files\Winnebago\Spectrum Server. You would edit this path only if
you move your server folder. Unless you have disk space
limitations, Sagebrush recommends that you install Spectrum
Server to the default location.

SERVER_NAME The unique name that identifies your server. This name is assigned
during installation. The default name is SERVER (all capital
letters). The server name can contain up to 13 characters and cannot
include spaces.

Important! If you have multiple Spectrum Servers on a Novell or
Windows-based computer, you must make sure each server has a
unique server name. Not only that, but the sum of the ASCII values
of the server names cannot equal the same number. For more
information on ensuring unique server names, see “Installing
multiple Spectrum Servers on Windows” or “Installing multiple
Spectrum Servers on Novell” in the Server chapter of the Spectrum
CIRC/CAT Installations Guide.

SYSLOG
DYNAMIC_DUMP

A command line necessary to run the Ctdump backup program.

USERS The maximum number of simultaneous user connections to the
Spectrum Server program. This number is set during installation by
your CD Key license, but may be edited to be less than the number
of locations allowed by your license. You may want to enter only
the number of users you are using (even if you are allowed more) to
help your server program use memory more efficiently. For
example, if you have at most only 35 users at one time, you can
enter 35 here. Then your server allocates only enough memory for
35 user connections. Note: If you use Web Catalog, you should not
reduce the number of connections allowed, because Web Catalog
may require many connections.
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Editing the configuration file
You probably won’t need to edit the Spectrum Server program’s configuration file, and
Sagebrush recommends that you don’t change any of its settings unless you consult your
network administrator or a Sagebrush Technical Support Specialist. Improper settings in
your configuration file may have adverse effects on the operation of your Spectrum
Server program. If you want to restore the configuration file to its default settings, you
can delete the ctsrvr.cfg file and reinstall Spectrum Server.

Note: The most common reason to edit the configuration file is to change the name of
your server (SERVER_NAME). You may also need to change your backup schedule (for
example, from weekly to daily).

Before you edit the ctsrvr.cfg file, you must shut down your Spectrum Server program.
When you restart Spectrum Server, the program reads and uses the new or changed
settings in the edited configuration file. Keep in mind that before you connect your
Spectrum client(s) to Spectrum Server for the first time, you must run Spectrum
Communications Setup on each client. See "Using Spectrum Communications Setup" in
the Spectrum CIRC/CAT Installations Guide for more information. After you change the
server name, you must run the Spectrum Communications Setup program to change the
server name on each client computer that connects to Spectrum Server.

How to edit the configuration file
Let’s say you want to change the server name from its default, SERVER, to LINCOLN.
You must edit the configuration file (ctsrvr.cfg) so that it contains the new server name.

Note: Before you edit the configuration file, it’s a good idea to copy the file into the
Backup directory to make sure you have a backup of the original file.

To edit the configuration file
1 Shut down all Spectrum client programs.

2 Shut down your Spectrum Server program.

3 Open the configuration file (ctsrvr.cfg) with a text editor such
as WordPad or SimpleText. The ctsrvr.cfg file is located in the
same folder as your Spectrum Server program.

4 In the SERVER_NAME command line, change SERVER to
LINCOLN.
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5 Save the edited text file, making sure that it has the same name
(ctsrvr.cfg) and location as before. Make sure that you save it as
a text-only file.

After you change the server name, you must run the Spectrum
Communications Setup program to change the server name on
each client computer that connects to Spectrum Server. See
"Using Spectrum Communications Setup" in the Spectrum
CIRC/CAT Installations Guide for more information.

Important! If you have multiple Spectrum Servers on a Novell or Windows-based
computer, you must make sure each server has a unique server name. Not only that, but
the sum of the ASCII values of the server names cannot equal the same number. For
more information on ensuring unique server names, see “Installing multiple Spectrum
Servers on Windows” or “Installing multiple Spectrum Servers on Novell” in the Server
chapter of the Spectrum CIRC/CAT Installations Guide.
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Starting and shutting down Spectrum Server

You must run the Spectrum Server program on your server computer in order to use the
client/server version of Spectrum CIRC/CAT. Improper use of the Spectrum Server
program may result in the loss of data.

Under normal operating conditions, you can keep Spectrum Server running indefinitely.
You do not need to shut it down on a nightly basis. However, if you do need to shut it
down, make sure you first shut down all Spectrum clients. Also, always shut down the
Spectrum Server program before you shut off the server computer. This helps ensure that
your data remains intact.

Starting Spectrum Server
After you install the Spectrum Server program, you must start it to run Spectrum
CIRC/CAT on your library’s network. Note: After you start Spectrum Server, you may
want to clear space on your server computer’s desktop by minimizing any windows
related to the Spectrum Server program.

You must keep your Spectrum Server program running whenever any Spectrum client is
running. Your server program must be running as long as your client programs (such as
Spectrum CIRC/CAT) need to access material data, generate reports, and so on.

Note: Before you connect a Spectrum client program to Spectrum Server for the first
time, you must run the Spectrum Communications Setup program on each client
computer to make sure the client is pointing to the correct server. You should start
Spectrum Server before you run the Spectrum Communications Setup program. For
detailed instructions on running the Spectrum Communications Setup program, see
"Using Spectrum Communications Setup" in the Spectrum CIRC/CAT Installations
Guide.
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To start Spectrum Server (Novell)
1 Access the Novell server computer’s system console.

2 Type load sys:\spectrum\ctsrvr.nlm ctsrvr_cfg
sys:\spectrum\ctsrvr.cfg and press Enter.

Note: If you moved or installed the Spectrum Server program
file (ctsrvr.nlm) to another location than "sys:\spectrum\" you
must enter the path for the new location when starting the
program. Also, ctsrvr.nlm may have been given a different
name during installation.

To start Spectrum Server (Windows)
From the Start menu, choose Programs > Winnebago Spectrum
Server (SERVER) > Spectrum Server.

When the server program loads, it opens the FairCom(R) Server
window (that contains Control and About menus) and the
FairCom(R) Server Message Monitor window. If you want, you
can minimize these windows.

FairCom Server
window (Spectrum
Server window)
You may want to clear
space on your server
computer’s desktop by
minimizing this window.
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FairCom Server
Message Monitor
window
This window displays any
messages related to your
Spectrum Server. It opens
with the window above.
You may want to minimize
this window to clear space
on your computer’s
desktop.

To start Spectrum Server (Mac OS)
Double-click the icon for the program (ctsrvr.ppc in the
Winnebago Spectrum Server folder) or its alias. When the server
program loads, it opens the FairCom Server window.

FairCom Server
window—Macintosh
This window displays any
messages related to your
Spectrum Server. It opens
with the window above.
You may want to minimize
this window to clear space
on your computer’s
desktop.
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Shutting down Spectrum Server
Remember to always shut down the Spectrum Server program before you shut off the
server computer. Also, you must always shut down all Spectrum client programs before
you shut down the Spectrum Server. If you don’t, you may corrupt files and lose data.

To shut down Spectrum Server (Novell)
1 Access the Novell server computer’s system console.

2 Type unload ctsrvr (or the name of the .nlm file that was
renamed if the default name ctsrvr was not entered during
installation) and press Enter. Note: When you shut down
Spectrum Server (unlike when you start it) you don’t have to
tell the computer the path of the program.

The program informs you how many users are currently logged
on to the server and confirms that you want to shut down.

Confirmation
This window
displays how
many users are
currently logged
on and confirms
that you want to
shut down.

There should be no users logged on to the server. If the window
indicates that client programs (users) are still connected, you
should not shut down.
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Confirmation
If any client
programs are still
logged in to the
Spectrum Server,
shut them down
before you shut
down the server.

Note: If you or your patrons used Web Catalog to perform
searches, the server shutdown window may still indicate that
users are connected. If you are certain that all clients programs
are shut down, it is safe to shut down the server in this
circumstance.

3 If there are no users connected, type y and press Enter to shut
down. If there are any users still connected, type n and press
Enter, shut down the client programs, and repeat steps 1-3.

To shut down Spectrum Server (Windows and Macintosh)
1 From the FairCom(R) Server window, choose Control >

Shutdown (Windows) or File > Quit (Macintosh). The FairCom
Server Shutdown window opens and prompts for a user name
and password.

FairCom Server
Shutdown window
Here you must enter the
Admin user name and
password in order to shut
down Spectrum Server.

2 In the Administrator User box, enter ADMIN—in all capital
letters.
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3 In the Password box, enter the server’s administrator password
(the default password is ADMIN—in all capital letters). The
program displays an asterisk for each letter of the password that
you type.

Note: You should change the password so that only authorized
people can access server administrative functions.For more
information, see "Protection by a password" in this chapter.

4 Click OK.

A window informs you how many client programs (users) are
currently logged on to your Spectrum Server program. This
window also prompts you to confirm that you want to shut
down.

The number of users logged on should be zero (0). If this
window indicates that one or more client programs are still
connected, you should not shut down at this time. You should
make sure all Spectrum client programs are shut down and
then shut down the Spectrum Server program again. If you
shut down the server before shutting down any users logged
into the server, you can lose or corrupt your data.

Note: If you or your patrons used Web Catalog to perform
searches, the server shutdown window may still indicate that
users are connected. If you are certain that all clients programs
are shut down, it is safe to shut down the server in this
circumstance.

5 If there are zero users connected to the server, click OK
(Windows) or Yes (Macintosh) to shut down.

Server Shutdown
Confirmation window
Here you confirm that zero
users are connected.

If there are one or more users connected to the server, click
Cancel (Windows) or No (Macintosh), shut down all Spectrum
client programs, then repeat steps 1 through 5.
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Server Shutdown
Confirmation window
If any client programs are
still logged in to the
Spectrum Server, shut
them down before you
shut down the server.

When shutdown is complete, the FairCom(R) Server window
closes.

Shutting down Spectrum Server during backups
Depending on your backup method, you may or may not have to turn off your Spectrum
Server program when you make a backup of your Spectrum data.

If you use a third-party program to make backups, you need to shut down the Spectrum
Server program. If the Spectrum Server is running when a third-party program tries to
make backups of Spectrum files, the backup process may skip some files (those being
accessed by the Spectrum Server program), which would result in a bad backup.

If you use the Ctdump program, a backup program provided with Spectrum, Spectrum
Server must be running when Ctdump is backing up your Spectrum database.

For information on starting Spectrum Server as a Windows Service, see "Starting
Spectrum Server using Windows Service".
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Using Spectrum Server as a Windows Service
When you use the Spectrum Server program on a Windows NT or 2000 computer, you
can install and use Spectrum Server as a Windows Service. While installing the Spectrum
Server program on your Windows NT/2000 server computer, the installation program
asks whether you want to install the Spectrum Server program as a Windows Service.
When you answer yes, the installation continues with installing Spectrum Server while
enabling it as a Windows Service.

Why use a Windows Service? Enabling the Spectrum Server program as a Windows
Service provides you with extra protection and convenience.

• Protection. Using Spectrum Server as a Windows service, Spectrum
clients can connect to the Spectrum Server program even though not
actively logged on to the server computer. The server computer, for
example, can be at the Ctrl-Alt-Delete screen (not accepting user
input), and Spectrum clients can still access the functions of the
Spectrum Server program.

• Convenience. Using Spectrum Server as a Windows Service, you can
start up and shut down the Spectrum Server program from a client.
When you can’t access the server computer directly, it can be very
useful to be able to access Spectrum Server functions remotely (from
a client computer with administrative rights).
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Starting Spectrum Server using Windows Service
On Windows NT and Windows 2000, you can run Spectrum Server as a Windows
Service. Although you register your Spectrum Server program as a Windows Service
during installation, you still have to start Spectrum Server as a Windows Service before
the protection and convenience of Windows Services can be used for your server
program.

You start Spectrum Server through the Services Control Panel. If the Server program
(listed as FairCom Server (SERVER), where SERVER is the server name you specified
during installation) isn’t listed in the Services window, you must reinstall the server
program and choose to install it as a Windows Service (see "Spectrum Server as a
Windows Service" in the Spectrum CIRC/CAT Installations Guide).

To start Spectrum Server as a Windows Service
1 Click the Start menu and select Settings > Control Panel. . (In

Windows 2000, select Programs > Admin Tools > Services.)

2 In the Control Panel window, double-click the Services icon.
The Services window opens.

The default name of
the Spectrum Server
Windows Service is
FairCom Server
(SERVER).

Services
This window lists the
available Windows
Services on your
computer and their
statuses.

A service that is
currently running has
a status of "Started."

3 Select FairCom Server (SERVER) and click Start.

Windows Service tells you that it’s trying to start the program.

When the Service Control window closes, you can exit Windows
Service.

4 Click Close.
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Shutting down Spectrum Server using Windows Service
Sagebrush recommends that you never shut down the Spectrum Server program while
users are connected. However, if your Spectrum Server program is on a computer with
Windows NT or Windows 2000 and you are running Spectrum Server as a Windows
Service, it can be difficult to tell if users are connected when using Windows Service.
When you shut it down the usual way, such as accessing it at the server computer and
selecting Control > Shutdown, the server program tells you how many users are currently
connected and confirms you want to shut down. But when you stop the server program
through Windows Service, you aren’t told whether any users are connected.

Before you stop the server program through Windows Service, you should use the
Ctadmn program to check the number of users accessing it (use the option "List Attached
Clients"). You can find the Ctadmn program in the FairUtil folder on the server
computer, which you can access from a client computer with administrative rights. You
need to know the administrator user ID and password to check for users.

To check for users accessing Spectrum Server
1 Make sure Spectrum Server is running.

2 Start the administrator program. You do this by double-clicking the
ctadmn.exe file, which is located in the c:\Program
Files\Winnebago\Spectrum Server\FairUtil folder. (This is the default
folder. Your location may be different if you changed the default
location of your Spectrum Server program during installation.) When
the Ctadmn program starts, it prompts for your administrator user ID.

3 Type the administrator user ID (the default administrator ID is ADMIN–
in all capital letters) and press Enter.

4 Type the administrator password (the default administrator password is
ADMIN–in all capital letters) and press Enter.

5 At the Optional File Password prompt, type your optional password
and press Enter. If you don’t have an optional password set up, press
Enter.
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Ctadmn.exe
This window
lets you access
the FairCom
Server
Administration
Utility
program.

6 At the Optional Server Name prompt, type the name of your
Spectrum Server and press Enter (the default server name is SERVER–in
all capital letters).

If all information is entered correctly, the FairCom (R) Server
Administration Utility window opens.

Ctadmn.exe
This window
displays the
main menu of
the FairCom
Server
Administration
Utility
program.

7 From the Ctadmn program’s first menu, type 4 (Monitor Clients) and
press Enter.

8 From the Monitor Clients menu, type 1 (List Attached Clients) and
press Enter.

The client information is displayed, including how many users are
accessing Spectrum Server. Note: A backup script (spcdaily.txt,
spcwkly.txt, or spcnow.txt) may display as a client logged on to the
server. You may shut down the server if one of these is the only client
logged on.
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9 After you’re finished viewing the information on screen, press Enter.

10 Type q and press Enter to return to the previous menu(s), then type q
and press Enter again to exit the Ctadmn program.

If there are no users connected to the server (other than a backup script), you can safely
shut it down. If clients are connected, you must shut them down before you shut down
Spectrum Server.

To shut down Spectrum Server using Windows Service
1 Click the Start menu and select Settings > Control Panel. (In

Windows 2000, select Programs > Admin Tools > Services.)

2 In the Control Panel window, double-click the Services icon.
The Services window opens.

3 Select FairCom Server (SERVER) and click Stop.

Windows Service verifies that you want to stop the service.

4 Click Yes.

5 Click Close.

For information on starting Spectrum Server as a Windows Service, see "Starting
Spectrum Server using Windows Service".

Disabling Spectrum Server as a Windows Service
You disable Spectrum Server through the Services Control Panel.

To disable Spectrum Server as a Windows Service
1 Click the Start menu and choose Settings > Control Panel.

2 In the Control Panel window, double-click the Services icon.

The Services window opens. The Spectrum Server Windows
Service is listed as FairCom Server followed by the server name.
If you use the default server name, SERVER, the name of the
Spectrum Server Windows Service is FairCom Server (SERVER).
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The default name of the
Spectrum Server Windows
Service is FairCom Server
(SERVER).

Services
This window lists the
available Windows
Services on your
computer and their
statuses.

A service that is
currently running has
a status of “Started.”

3 If the service is running, select FairCom Server (SERVER)
(where SERVER is the server name you set up during
installation) and click Stop.

A window opens to confirm you want to stop the Windows
Service.

4 Click Yes. A Service Control windows opens to inform you that
it’s trying to stop the service.

5 After the Service Control window closes, click Startup.

The Service window opens.

Service
In this window,
you set the
appropriate
options for your
Windows Service.

You disable the
Windows Service
by selecting the
Disabled option.

6 Select Disabled and click OK.

The window closes, returning you to the Services window. In
the Startup column, the service should be listed as “Disabled.”

7 Click Close.
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Removing Spectrum Server as a Windows Service
The installation program installs a shortcut to remove the Windows Service.

To remove Spectrum Server as a Windows Service
On your Start menu, select Programs > Spectrum Server >
Remove Service FairCom Server (SERVER) (where SERVER is the
server name you set up during installation). Spectrum Server is
still installed on your server computer, but not as an Windows
Service.

If you decide you want to begin using Spectrum Server as a Windows Service after you
remove it, you must reinstall Spectrum Server.
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Safeguarding your Spectrum Server

You should safeguard your Spectrum Server program and all your Spectrum data by
restricting access to it. You can restrict access in two ways:

• Physically preventing others from accessing the server computer, and

• Using a password.

Protection by physical location
Although Spectrum Server comes with built-in password protection, Sagebrush
recommends that you implement some form of physical security (for example, keeping
your server computer in a locked room). Often the best way to safeguard your computer
data is to safeguard the computer. Note: A password is not required to start the Spectrum
Server program.

Protection by a password
When first installed, the Spectrum Server program recognizes only one user, a user that is
intended to be the server administrator. This user has the unchangeable user ID name of
ADMIN and the initial password of ADMIN. Anyone who knows the administrator user
ID and password can perform powerful administrative functions.

Immediately after you install your Spectrum Server program (see your Spectrum
CIRC/CAT Installations Guide for installation information), you should change this
password and keep the new password secure. Changing the administrator password helps
protect the Spectrum Server program from being accessed by unauthorized persons. Your
changed password is maintained even if you reinstall Spectrum Server. (Note: If your
Spectrum Server program is on a Novell computer and you’re upgrading from Spectrum
Server 3.x to Spectrum Server 5.0, your changed password reverts to ADMIN.)

Important! Make sure you write down your new password. Sagebrush provides a place
for you to write down your Spectrum Server administrator password on the Passwords
level worksheet. You can find this worksheet in the "Setting up passwords" section of the
Setup chapter in the Spectrum CIRC/CAT User Manual.
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How to change the Spectrum Server password
After you install Spectrum Server, you should immediately change the password so that
only authorized people can access server administrative functions.

To change the Spectrum Server password
1 Make sure Spectrum Server is running.

2 Start the administrator program. You do this by double-clicking
the Ctadmn.exe file, which is located in the c:\Program
Files\Winnebago\Spectrum Server\FairUtil folder. (This is the
default location. Your location may be different if you changed
the default location of your Spectrum Server program during
installation.) When the Ctadmn program starts, it prompts for
your administrator user ID.

3 Type the administrator user ID (ADMIN—in all capital letters)
and press Enter.

4 Type the administrator password (the default is ADMIN—in all
capital letters) and press Enter.

5 At the Optional File Password prompt, type your optional
password and press Enter. If you don’t have an optional
password set up, press Enter.

6 At the Optional Server Name prompt, type the name of your
Spectrum Server and press Enter (the default server name is
SERVER—in all capital letters).

Ctadmn
window
Here you must
enter the Admin
user name and
password to
access the
administrator
program.

If all information is entered correctly, the FairCom (R) Server
Administration Utility window opens.
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Ctadmn—
Faircom Server
Administration
Utility window
Here you choose the
menu option for
various functions in
the Spectrum Server
administrator
program.

7 From the Ctadmn program’s first menu, choose 1 (User
Operations) and press Enter.

8 From the User Operations menu, choose 4 (Change User
Password) and press Enter.

9 When prompted to enter a user ID, type ADMIN. Then, type the
new password and press Enter. Finally, type the new password
again to confirm it and press Enter.

10 Type q and press Enter to return to the previous menu(s), then
type q and press Enter again to exit the Ctadmn program.

11 For Mac OS only, at the message prompt "Session Completed",
choose Quit from the File menu. Choose No when it asks if you
want to save the output.

Your changed password is maintained even if you reinstall
Spectrum Server. Note: If your Spectrum Server program is on a
Novell computer and you’re upgrading from Spectrum Server
3.x to Spectrum Server 5.0, your changed password reverts to
ADMIN.

Important! Make sure you write down your new password. Sagebrush provides a place
for you to write down your Spectrum Server administrator password on the Passwords
level worksheet. You can find this worksheet in the "Setting up passwords" section of the
Setup chapter in the Spectrum CIRC/CAT User Manual.
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Monitoring server activity

The Spectrum Server program lets you monitor server activity by recording its actions
and their results in two ways:

• on screen, and

• in a status (or log) file.

When the Spectrum Server program starts on a Windows or Macintosh computer, it
verifies the database integrity and the operation of its own components. If it detects any
problems, the server displays error messages on the system console (the Message
Monitor window) and places them in the status log. On Novell servers, the Message
Monitor window is not displayed. Instead, a system status screen is displayed.

Viewing activity on screen
The Spectrum Server program displays much of its activity in the FairCom(R) Server
Message Monitor window.

FairCom Server
Message Monitor
window
This window displays any
messages related to your
Spectrum Server. You may
want to minimize this
window to clear space on
your computer’s desktop.
Note: If you use Windows
Service, the Message
Monitor window is not
displayed.



502 Spectrum CIRC/CAT User Manual
SCC5um1200kn

Remember, you can view FairCom Server Message Monitor window window only on the
server computer. On a Windows computer, the FairCom Server Message Monitor
window may be automatically minimized when Spectrum Server is started. You may
need to maximize the window and then scroll to view its messages. This window displays
activity only from the current server session. If you need to see server activity from
before Spectrum Server was restarted, you must refer to the ctstatus.fcs log file.

Reading activity in the ctstatus.fcs log file
The Spectrum Server program keeps an ongoing record of server activity in a text file
called ctstatus.fcs. This file resides on the server computer in the Spectrum Server folder.
Below are the contents of the Spectrum Server’s ctstatus.fcs file as displayed in WordPad
or SimpleText.

ctstatus.fcs log file
This log file displays
any server activity
related to your
Spectrum Server.

As soon as the Spectrum Server program starts, it keeps track of critical data concerning
the status of the server (such as when it started, any error conditions that have been
detected, and if it was shut down properly). This data is saved in chronological order in
the ctstatus.fcs file. If your Spectrum program encounters a problem that requires you to
restore data, this log file may contain important information about the problem. Note:
Oldest entries are overwritten once the file exceeds the CTSTATUS_SIZE value in the
ctsrvr.cfg file.
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Troubleshooting server error messages
If your Spectrum Server program displays an error message, you should contact
Sagebrush’s Technical Support Department. However, you may want to see if you can
find out more about the error message on your own. For that reason, there is a text file
called fh.txt (for "FairCom Help") installed on your server computer which lists error
messages and some causes. Depending on the type of error, you may find something that
provides a clue to your problem. To view the file, open Spectrum Server\FairUtil\fh.txt
(default path) on your server computer.

Note: FairCom Help, or fh.txt, is not available on a Mac OS server.
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